Epson Stylus® C88

Quick Guide
Contents

Introduction ................................................................. 3

Loading Paper .............................................................. 4

Basic Printing ............................................................... 6
  Printing in Windows ......................................................... 6
  Printing with Macintosh OS X ........................................... 9
  Using Special Papers ..................................................... 13

Printing Photos ............................................................ 15
  Printing Photos in Windows .............................................. 15
  Printing Photos with Macintosh OS X ................................. 19

Replacing Ink Cartridges ................................................ 23
  Purchasing Ink Cartridges .............................................. 23
  Ink Cartridge Precautions .............................................. 24
  Removing and Installing Ink Cartridges ............................... 25

Solving Problems .......................................................... 29
  Checking the Printer's Lights .......................................... 29
  Problems and Solutions ................................................ 30
  Where To Get Help ....................................................... 32

Requirements and Notices ............................................... 34
  Windows System Requirements ........................................ 34
  Macintosh System Requirements ...................................... 34
  Important Safety Instructions ......................................... 35
  FCC Compliance Statement ........................................... 37
  Declaration of Conformity ............................................. 38
  ENERGY STAR Compliance ........................................... 38
  Epson America, Inc. Limited Warranty ............................... 39
Introduction

The Epson Stylus® C88 printer is the ideal desktop printer for business and home use. With its exceptional speed and print resolutions, it is practical for everyday tasks, yet capable of delivering superior photo printing.

The Stylus C88 features Epson's exclusive DURABrite® Ultra pigment inks. These quick-drying inks are resistant to water, fading, and smudging on plain and photo paper—so your prints stand the test of time. Because the ink particles remain near the surface and don't bleed through, they're ideal for double-sided prints.

Note:
The light resistance of prints is rated up to 100 years on specialty papers, and 70 years on plain paper. The light resistance rating is based on accelerated testing of prints on Epson® special media, displayed indoors, under glass. Actual print stability will vary according to media, printed image, display conditions, light intensity, humidity, and other atmospheric conditions. Epson does not guarantee the longevity of prints. For maximum print life, display all prints under glass or lamination or properly store them.

After you have set up your Epson Stylus C88 as described on the Start Here sheet, use these instructions to:

- Load paper
- Print from Windows® or on a Macintosh®
- Replace ink cartridges
- Solve simple problems

For more information about your printer, see the on-screen User’s Guide. An icon for the manual was automatically placed on your desktop when you installed the software.

Please follow these guidelines as you read the instructions:

Warning:
Warnings must be followed carefully to avoid bodily injury.

Caution:
Cautions must be observed to avoid damage to your equipment.

Note:
Notes contain important information about your printer.

Tip:
Tips contain hints for better copying, scanning, and printing.
Loading Paper

The type of paper you choose affects the way your printout looks, so be sure to select the correct paper for your job. If you are just printing a rough draft, plain paper is fine. For best results, however, you'll want to use one of Epson's special ink jet papers designed for your printer. For example, your photos will look great printed on Epson Premium Glossy Photo Paper. See page 13 for more information.

Follow these steps to load paper in your printer:

1. Open the output tray and pull out its extension.

2. Squeeze the left edge guide and slide it to the left.
3. Insert the paper, printable side up, against the right edge guide. Then slide the left edge guide against the paper (but not too tightly).

**Note:**
You can load up to 100 sheets of plain paper and up to 20 sheets of most types of photo paper. (See the on-screen User’s Guide for specific paper capacity guidelines.)

Follow these guidelines when loading paper:
- Don’t load paper above the arrow on the left edge guide.
- Load the printable side face-up. It’s often brighter or whiter than the other side.
- Always load the short edge first, even when printing in landscape mode.
- Load letterhead or preprinted paper into the printer top edge first.
- If you experience paper feeding problems, try loading fewer sheets.
- If you’re using special paper, check the package for special loading instructions.
Basic Printing

Follow the instructions in this section for basic printing of your documents. For Windows, see below. For Macintosh OS X, see page 9.

If you are printing photographs, also see page 15 for more information about printing photos.

Printing in Windows

1. Open the File menu and select Print. You see a Print window like this one:

   ![Print Window](Image)

   Select EPSON Stylus C88 Series

   Click here to open your printer software

2. Make sure EPSON Stylus C88 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or Options button, click it. Then click Properties or Preferences on the next screen.)
You see the basic print settings window:

4. Select from these Quality Option settings:
   - **Draft**: For rough drafts with reduced print quality
   - **Text**: For text-only documents with higher text quality
   - **Text & Image**: For documents with text and images with higher quality
   - **Photo**: For photos and graphics with good quality and speed
   - **Best Photo**: For photos or graphics with high print quality

5. Select the correct paper **Type** and **Size** settings for the paper you loaded in the printer. See “Selecting the Correct Paper Type” on page 14.

6. Select **Portrait** or **Landscape** for the Orientation setting.
7. For more printing options, click the **Advanced** button. Then select the following settings as necessary.

   - Select a color management method (To choose No Color Adjustment, click ICM first).
   - Click here to select Photo RPM for the best print quality on certain paper types.
   - Select **Paper & Quality Options** as necessary.
   - Select **Print Options** as necessary.

   **Note:**
   For more information about advanced settings, or instructions on saving them as a group so you can reuse them later, click ? or Help.

8. If you want to change the layout settings, click the **Page Layout** tab and select settings as necessary.

9. Click **OK** to save your settings, then click **OK** or **Print** to start printing.

8 Basic Printing
During printing, this window appears to show the progress of your print job. You can use the buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

Tip:
You can also cancel printing by pressing the paper button on your printer.

Printing with Macintosh OS X

Follow the steps below for basic printing of your Macintosh OS X documents. Before you begin, make sure you added your printer to the Print Center as described on the Start Here sheet.

1. Open the File menu and select Page Setup. You see the Page Setup window:
2. Select **Stylus C88** in the Format for pop-up menu.
3. Select your Paper Size. For borderless printing, choose a paper size with the **Sheet Feeder-Borderless** option.
4. Select portrait or landscape for the orientation.
5. Click OK.
6. Open the File menu and select **Print**. You see a window like this one:

7. Select **Stylus C88** in the Printer pop-up menu.
8. Select **Print Settings** from the pop-up menu.
9. Select the following Print Settings as necessary:
Depending on your settings, you can choose these other options from the pop-up menu:

- **Copies & Pages**: Select the number of copies you want, or a page range.
- **Layout**: Select page layout options.
- **Output Options**: Save your print job as a PDF file.
- **Scheduler**: Schedule your print job to print at a later time.
- **Paper Handling**: Select page printing options, such as **Reverse print order**.
- **ColorSync or Color Management**: Select ColorSync® or adjust the color controls, change the gamma setting, or turn off color adjustments in the printer software.
- **Expansion**: Reduce or enlarge the image size for borderless printing.
- **Summary**: View a list of all your selections.

10. Click the **Advanced** button to change these settings:

![Advanced Settings](image)

**Note:**
For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click ?.

11. Click **Print**.
12. To monitor the progress of your print job, click the printer icon when it appears in the dock on the bottom of your desktop. If you’re using OS X 10.2.x, click the Print Center icon instead, then double-click Stylus C88 in the Printer List window. You see a screen like this:

Tip: You can also cancel printing by pressing the paper button on your printer.

13. When you’re finished, close the printer window or Print Center.
Using Special Papers

You can use the following special Epson papers in your Stylus C88.

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Glossy Photo Paper</td>
<td>Borderless 4 × 6 inches</td>
<td>S041934</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041935</td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Borderless 4 × 6 inches</td>
<td>S041808</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041286</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041331</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Borderless 4 × 6 inches</td>
<td>S041809</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041272</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041061</td>
</tr>
</tbody>
</table>

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller referral.
Selecting the Correct Paper Type

Be sure to select the correct Type or Media Type setting in your printer software:

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Glossy Photo Paper</td>
<td>Ultra Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>Epson Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
Printing Photos

You can print beautiful snapshots and enlargements with or without white borders. With proper care, photographs from your Epson Stylus C88 will last for many years. For best results, always use Epson papers. (See “Using Special Papers” on page 13 for more information.)

As with traditional photos, Epson recommends proper care that will minimize color changes and lengthen display life:

■ Frame prints under glass or in a protective plastic sleeve to protect them from atmospheric contaminants like humidity, smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ For proper storage, keep your prints in a photo album or plastic photo storage box in acid-free, archival sleeves commonly available from most camera stores.

■ Always keep unused paper in the original package.

For instructions on loading photo paper, see page 4. Then see below for printing in Windows, or page 19 for printing in Mac OS X.

Printing Photos in Windows

1. Open the File menu and click Print.

2. Make sure your printer is selected, then click Properties or Preferences. (If you see a Setup, Printer, or Options button, click it. Then click Properties or Preferences on the next screen.)
3. Select **Photo** or **Best Photo** as the Quality Option setting.

4. Select the paper **Type** for the paper you're using. (See page 14.)

5. For pictures without white borders, click the **Borderless** checkbox. Read the message and click **OK**.

6. Select your paper **Size** setting.

7. Select **Portrait** or **Landscape** as the orientation setting.

8. Do one of the following:
   - Click **OK**, then click **OK** or **Print**.
   - If you want to print at the highest resolution possible, or use special settings, continue with the steps in the next section.
Customizing Your Photo Settings

1. On the Main tab, click the Advanced button in the bottom right corner of the window. If you see a warning note, click Continue.

2. Select the following advanced settings as necessary:

   Select a color management method
   (To choose No Color Adjustment, click ICM first)
   Click here to select Photo RPM (5760 x 1440) for the best print quality on certain paper types
   Adjust colors here

   Note:
   For the highest print quality, select Photo RPM. Please note that printing will take longer in this mode and it is not available if you choose the Borderless checkbox.
   For more information about the print settings, click ? or Help.

3. Once you’ve finished selecting advanced settings, you can:

   ■ Click OK to save your settings, return to the Print window, and print.
   ■ Click the Basic button to return to the basic settings.
   ■ Click the Page Layout tab and continue with step 4 to select layout options.
4. Select the following page layout settings as necessary:

![Page Layout Settings](image)

**Note:**
Some layout settings may not be available, depending on other settings you chose.

5. Select image position or resizing options as necessary. These affect only your printed image, and are not available for borderless printing.

6. If you're printing borderless photos, you can adjust the Expansion slider to choose Min, Max, or the in-between setting.

   - **Min** is the least amount of image expansion; there may be a small white edge on the borders of the print.
   - **Max** expands the image to ensure that there are no unprinted edges, but the edges of the image may not appear in the print.

7. Click OK to save your settings, then click OK or Print.
Printing Photos with Macintosh OS X

1. Start your photo program and open your photo file.

2. Open the File menu and select Page Setup. You see a window like this one:

3. Select Stylus C88 in the Format for pop-up menu.

4. Select your Paper Size. For borderless photos, choose one of the following:
   - 4 x 6 (Sheet Feeder-Borderless)
   - 5 x 7 (Sheet Feeder-Borderless)
   - 8 x 10 (Sheet Feeder-Borderless)
   - Letter (Sheet Feeder-Borderless)

5. Select portrait or landscape as the orientation setting.

6. Click OK.

7. Open the File menu and click Print.
8. Select **Stylus C88** in the Printer menu and select **Print Settings** from the pop-up menu. You see a window like this one:

9. Select the correct **Media Type** option to match the paper you're using. (See “Selecting the Correct Paper Type” on page 14 for more information.)

10. Select **Quality** (for higher quality) or **Speed** (for faster printing) using the slider.

11. Do one of the following:
   - Click **Print**.
   - If you want to print at a higher resolution or use special settings, continue with the steps in the next section.
**Customizing Your Photo Settings**

1. Click the **Advanced** button.

2. Select these advanced settings as necessary:

   - **Note:**
     For the highest print quality, select **Photo RPM**. Note that printing will take longer in this mode.

     For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click the ? button.

3. If you're printing photos without white borders, select **Expansion** from the pop-up menu. You see a window like this one:
4. Adjust the Expansion slider to choose Min, Max, or the in-between setting. Min is the least amount of image expansion; there may be a small white edge on the borders of the print. Max expands the image to ensure that there are no unprinted edges, but the edges of the image may not appear in the print.

5. Click Print.
Replacing Ink Cartridges

When the red ink light flashes, one or more ink cartridges are low on ink. When the red ink light stays on, you need to replace the cartridge(s). When you print, you’ll also see a message on your screen telling you which cartridge is low or empty.

When a cartridge is more than six months old, you may need to replace it if printouts don’t look their best. If the quality doesn’t improve after cleaning and aligning the print head, you can replace the cartridge even if the red ink light is off.

Note:
You cannot continue printing with one ink cartridge empty, even if the other cartridges still contain ink. Before printing, replace the empty cartridge.

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the expiration date on the package.

<table>
<thead>
<tr>
<th>Ink cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T060120</td>
</tr>
<tr>
<td>Cyan</td>
<td>T060220</td>
</tr>
<tr>
<td>Magenta</td>
<td>T060320</td>
</tr>
<tr>
<td>Yellow</td>
<td>T060420</td>
</tr>
</tbody>
</table>

To ensure good results, use genuine Epson ink cartridges and do not refill them. Other products may cause damage to your printer not covered by Epson’s warranties. You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller referral.
Ink Cartridge Precautions

**Warning:**
Keep ink cartridges out of the reach of children.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them immediately with water.

**Caution:**
Don’t remove the cartridge label, or ink will leak.

Don’t remove the green IC chip from the cartridge. Installing a cartridge without an IC chip can damage the printer. Avoid touching the green IC chip, as this can damage the ink cartridge.

If you remove an ink cartridge temporarily, protect the ink supply port on the bottom of the cartridge from dirt and dust. Place it in the original packaging, if you still have it, or in a small box.

Store ink cartridges in the same environment as the printer. Stand the cartridges upright (the label identifying the color should be on top).
Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a cartridge, you must complete all the steps in one session.

Caution:
Leave the empty/low cartridge installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

1. Make sure the printer is turned on (the green power light should be on, but not flashing).
2. Open the printer cover.
3. Press and release the ink button.
   The ink cartridge holder moves to the left, and the cartridge that needs to be replaced stops under the ink out mark. The power light flashes.

Caution:
To avoid damaging the printer, never move the print head by hand.

Note:
Don’t hold down the ink button for more than 3 seconds, or the printer will start to clean the print head.

If no cartridge needs to be replaced, the holder moves to the ink cartridge replacement position, shown on the next page. Go to step 5.
4. Press the △ ink button again.

- If more than one cartridge is empty, the next cartridge moves under the 📜 ink out mark.
- If all the empty cartridges have been identified, the print head moves right to the ink cartridge replacement position, shown below.

5. Open the cartridge cover.
6. Squeeze the back tab of the empty/low cartridge and lift it out of the printer. Don't take the used cartridge apart or try to refill it.

Warning:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water.

7. Before you remove the new cartridge from its package, shake it four or five times. Then remove it from the package.

Caution:
Do not remove or tear the label on the cartridge; otherwise ink will leak.

Don't touch the green chip on the front of the cartridge; you may inhibit normal operation and printing.
8. Lower the cartridge into the holder and push it down until it clicks into place.

9. If you need to replace other ink cartridges, repeat steps 6 through 8 before continuing with step 9.

10. Close the ink cartridge cover and make sure you hear it click into place.

11. Close the printer cover.

12. Press the ink button. The printer begins charging the ink delivery system.

   The green power light flashes and the printer makes noise. Charging takes about half a minute. When it's finished, the green power light stops flashing and stays on, and the red light goes out.

   **Caution:**
   Never turn off the printer while the green power light is flashing, or you'll waste ink.

   **Note:**
   If the red light stays on (not flashing), the ink cartridge may not be installed correctly. Press the ink button again and reinstall the ink cartridge until it clicks into place.
Solving Problems

If you have a problem with your Epson Stylus C88, check the printer's lights (as described below) to diagnose what may be causing it.

You can also see “Problems and Solutions” on page 30 for basic troubleshooting suggestions, or read your on-screen User’s Guide for more detailed help.

If you cannot solve the problem, see “Where To Get Help” on page 32.

---

Checking the Printer’s Lights

<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green power light flashes</td>
<td>The printer is receiving a print job, replacing an ink cartridge, charging ink, or cleaning the print head.</td>
</tr>
<tr>
<td>Red paper light is on</td>
<td>Your paper ran out. Load more paper, then press the paper button to resume printing.</td>
</tr>
<tr>
<td>Red paper light flashes</td>
<td>Paper is jammed in the printer. Press the paper button to eject the paper. If that doesn’t work, turn off the printer, open the cover, and pull the paper out from the front, including any torn pieces. Then turn on the printer, reload paper, and press the paper button.</td>
</tr>
<tr>
<td>Red ink light flashes</td>
<td>One of the cartridges is low on ink. Check the message that appears on your screen to determine which cartridge is low. Make sure you have a replacement cartridge.</td>
</tr>
<tr>
<td>Red ink light is on</td>
<td>One of the cartridges is out of ink or not installed. Make sure you have a replacement cartridge, then follow the steps on page 25 to install it. If you have just installed a new cartridge, it may be incompatible with the printer or incorrectly installed. Reinstall it or replace it with the correct cartridge.</td>
</tr>
<tr>
<td>Green power light and red ink light are on</td>
<td>An ink cartridge is not installed correctly. Reinstall it as described on page 25.</td>
</tr>
</tbody>
</table>
Problems and Solutions

You see banding (light lines).

- Make sure the paper Type or Media Type setting matches the paper you’re using.
- The print head nozzles may need cleaning; follow the instructions below to clean the print head:
  1. Make sure the printer is turned on but not printing, and the red ◯ ink light is off.
  2. Windows: Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Head Cleaning.

  Note:
  If you don’t see the icon, go to your printer properties window as described on page 6, click the Maintenance tab, then select Head Cleaning.

<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red ◯ paper and ◯ ink lights flash alternately</td>
<td>Paper may be blocking movement of the print head. Turn off the printer, then open the cover and remove any jammed paper or other foreign objects. Turn the printer back on. If the lights are still on, contact Epson as described on page 32.</td>
</tr>
<tr>
<td>Green ◯ power light is off; red ◯ paper and ◯ ink lights flash</td>
<td>The printer may have an internal error. Turn off the printer, wait a few seconds, and turn it on again. If the lights are still flashing, contact Epson as described on page 32.</td>
</tr>
</tbody>
</table>
Macintosh OS X: Open the Applications folder and select Epson Printer Utility. Select Stylus C88 in the printer list, click OK, and select Head Cleaning.

3. Click Start or Next.

Cleaning takes several seconds. The printer makes noise and the green power light flashes.

**Caution:**
Never turn off the printer while head cleaning is in progress. You may damage the printer.

4. When the green power light stops flashing, make sure paper is loaded in the printer, then do the following:

**Windows:** Click Print Nozzle Check Pattern. Then click Print.

**Macintosh:** Click Confirmation, then click Next.

The nozzle check pattern prints.

5. If the nozzle check pattern has no gaps or white lines as shown, click Finish.

If the pattern has gaps or is faint, click Clean to clean the print head again.

You can also turn the printer off and wait overnight. This allows any dried ink to soften. Then try cleaning the print head again.

- The ink cartridges may need replacing; see page 25 for instructions.

**Your printout is blurry or smeared.**

- Make sure the printable (whiter) side of the paper is face-up.

- Use Epson papers to ensure proper saturation and absorption of genuine Epson ink.

- You may need to align the print head. See the on-screen User’s Guide for instructions.
Your paper doesn’t feed correctly or jams in the printer.

- If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to separate the sheets, then reload it.
- If paper jams, press the paper button for several seconds to clear the jam. If that doesn’t work, open the cover and pull the paper out from the front, including small pieces that may have torn off. Reload the paper and press the paper button.
- Heavily saturated prints may curl, causing a paper jam when printing on both sides of the paper.
- Make sure you use new, smooth, high-quality paper, loaded printable side up.
- Don’t load paper above the arrow mark inside the left edge guide.
- Place the paper against the right edge, behind the tab. Slide the left edge guide against it, but not too tightly.

Where To Get Help

Epson provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed in the following table.

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach Epson Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone Services</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911. Your Epson SoundAdvice℠ Express Code is 70645. Use this code to quickly select the Epson Stylus C88 in SoundAdvice.</td>
</tr>
</tbody>
</table>
To speak to a technical support representative, dial:

■ U.S.: (562) 276-7525, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday.

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Please have the following information ready:

■ Product name (Epson Stylus C88)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

■ Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To find the nearest reseller, please call 800-GO-EPSON (800-463-7766). To purchase online, visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for reseller referral.

### Other Software Technical Support

<table>
<thead>
<tr>
<th>Software</th>
<th>Telephone/Fax</th>
<th>Online and E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArcSoft PhotoImpression™</td>
<td>(510) 440-9901</td>
<td><a href="http://www.arcsoft.com">www.arcsoft.com</a></td>
</tr>
<tr>
<td></td>
<td>8:30 AM—5:30 PM, Pacific Time, Monday—Friday</td>
<td><a href="mailto:support@arcsoft.com">support@arcsoft.com</a></td>
</tr>
<tr>
<td></td>
<td>Fax: (510) 440-1270</td>
<td></td>
</tr>
</tbody>
</table>
Requirements and Notices

Windows System Requirements

- A Microsoft® Windows compatible PC with a Pentium®-equivalent processor (233 MHz or faster recommended)
- Microsoft Windows 98SE, Windows Me, Windows 2000, or Windows XP
- At least 64MB RAM (128MB recommended)
- 100MB free hard disk space (200MB or more recommended)
- VGA or better display adapter and monitor (SVGA for Windows XP)
- CD-ROM or DVD drive for installing the printer software
- Parallel connection: a high-speed, bidirectional IEEE-1284 compliant parallel cable, up to 10 feet long (3 meters); the cable must have a D-SUB, 25-pin, male connector for your computer, and a 36-pin, Centronics® compatible connector for the printer.
- USB connection: a computer with preinstalled Windows 98 SE, Me, 2000, or XP, and a Windows-compliant USB port and shielded USB “AB” cable. Using an improperly shielded USB cable may cause the printer to malfunction.

Macintosh System Requirements

- An Apple® iMac™ series or Power Macintosh G3, G4, or G5 with a built-in USB port
- Macintosh OS X 10.2 or later
- 128MB RAM (256MB recommended)
- At least 100MB free hard disk space (200MB recommended)
- VGA display or better
- CD-ROM or DVD drive for installing the printer software.
- A shielded USB “AB” cable. Using an improperly shielded USB cable may cause the printer to malfunction.
Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and effectively:

- Be sure to follow all warnings and instructions marked on the printer.
- Use only the type of power source indicated on the printer’s label.
- Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Place the printer near a wall outlet where the plug can be easily unplugged.
- Do not let the power cord become damaged or frayed.
- If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the outlet’s ampere rating.
- Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
- Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
- Leave enough room around the printer for sufficient ventilation, leaving at least 3.9 inches between the back of the printer and the wall.
- Do not place the printer near a radiator or heating vent or in direct sunlight.
- Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
- When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it upside-down. This may allow ink to leak from the ink cartridges.
- Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.

**Caution:** Always turn the printer off using the power button. Don’t switch off the power strip or unplug the printer until the green power light is off.

- Do not block or cover the openings in the printer’s case or insert objects through the slots.
- Except as specifically explained in this manual, do not attempt to service the printer yourself.
Unplug the printer and refer servicing to qualified service personnel under the following conditions:

- If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Do not put your hand inside the printer or touch a cartridge during printing.
- Do not move the print head by hand. You may damage the printer.
- Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.
- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of first installing them.
- Store ink cartridges in a cool, dark place.
- Store ink cartridges with the bottom of the packaging facing down.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Do not shake an ink cartridge after removing it from its package; this can cause leakage.
- Do not remove or tear the label on an ink cartridge; this can cause leakage.
- Do not dismantle the ink cartridges or try to refill them. This could damage the print head.
- Do not touch the green IC chip on the front of the cartridge. This may affect normal operation and printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
- Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are in place. Secure the ink cartridge holder with the included insert to make sure it remains in the proper position.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink Jet Printer
Model: B251A

ENERGY STAR Compliance

As an ENERGY STAR® Partner, Epson has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. Epson also warrants that the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty for the Epson printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-7525 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal use in the United States and Canada. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating
label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC., NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. - P.O. Box 93012 - Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and cameras, can be misused by improper copying or printing of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Epson encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

Epson and Epson Stylus are registered trademarks and Exceed Your Vision is a trademark of Seiko Epson Corporation.

DURABrite is a registered trademark and Epson Connection, Epson Store, and SoundAdvice are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

© 2005 Epson America, Inc. 5/05